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Version 18.12 Release Notes

This document provides important information regarding new features and changes in your Sage
Estimating 18.12 software. Read these release notes carefully before installing Sage Estimating 18.12.

Installation Notes

System Requirements

For current information about supported operating systems, Internet browsers, Microsoft® SQL Server®,
and other software, and about system requirements for servers and client workstations, refer to our
Knowledgebase article ID 91688, available at
https://support.na.sage.com/selfservice/viewdocument.do?externalId=91688.

Note:While Sage Estimating continues to support 32-bit Microsoft SQL Server, the installation package
includes only the 64-bit Microsoft SQL Server Express application.

Installing Sage Estimating

Refer to the Installation and Administration Guide for complete instructions on installing the software and
migrating or upgrading your data.

Before Upgrading

Important!
If you are upgrading to version 18.12 and you are using third-party software that integrates with Sage
Estimating, check with the third-party software vendor to ensure that their software is compatible with
version 18.12 before you upgrade.
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We've been listening to you!
Sage thanks you for your product ideas!

In Sage Estimating (SQL) version 18.12, we have incorporated the following customer requests:

l In the Alternate Summary, excluded alternates are no longer included in the Totals column.

Also, addons are no longer allocated to excluded alternates when you show excluded alternates.

l You can create variables and formulas "on the fly" from the Variable/Formula list when you add or
edit item tables or formula tables.

Later sections describe these enhancements in more detail.
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New Features and Enhancements

Sage Estimating version 18.12 includes the following significant improvements:

l Improvements to the Alternate Summary

l More efficient ways to copy assemblies and items

l A new tool in the EstimatingManagement Console that enables you tomerge standard databases

l The ability to create variables and formulas "on the fly" in the Variable / Formula List window

l The ability to migrate report layouts fromEstimating (Pervasive)

In addition, it includes somemiscellaneous improvements.

The following sections describe these changes in more detail.

View an improved Alternate Summary pane
In the Alternate Summary pane, addons are no longer allocated to excluded alternates when you show
excluded alternates, and the excluded alternates are no longer included in Total amounts.

To see the effect of an alternate on the total, select an included or excluded status by selecting it from the
dropdown list in the column header.

Tip: Excluded amounts are shown in red (unless you change the fonts for your spreadsheet layout),
providing a quick visual clue about the status of alternates.

For more information, see the Estimating help.

Copy assemblies and itemsmore efficiently
Versions 17.12 and 17.13 enhanced the drag-and-drop, Move, and Copy/Paste functionality on the
Estimating spreadsheet.
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Version 18.12 provides increased versatility that now enables you to:

l Copy and paste, or drag and drop, assemblies from any sequence to any other sequence, provided
you select a complete assembly. You can even drop items onto an empty estimate, or the gray area
below an estimate!

For example, you can drag any assembly overline, and then drop it within an estimate. You no
longer need to move items individually from sequences where Assembly is not the primary sort level.

(Previously, you could drag assemblies only from a sequence that had Assembly as the primary
grouping, and you could only drop the assembly on sequences that had reassignable levels.)

l Select multiple assemblies, or a combination of assemblies and items, and then drag them to
another estimate.

(Previously, you could only drag and drop one assembly at a time—and you could not mix individual
items with a selected assembly.)

Furthermore, the status bar now displays the number of selected individual items and complete
assemblies (similar to the Move/Copy window), so you know exactly what you are moving to the
other estimate.

l Use the Move/Copy window to move or copy items from all sequences.

l Use the Move/Copy and Copy/Paste windows to move a collapsed assembly overline from any
sequence.

Keep in mind the following results when moving or copying items and assemblies:

Moving within
an estimate*

Copying within
an estimate

Copying between
estimates

Add/delete
items?

No items are
created or
deleted.

Existing items are not
affected. New items are
created at the destination.

Existing items are not affected. New
items are created in the destination
estimate.

Different
sort level?

Item levels
change.

New items have different
levels in the estimate.

New items in the destination estimate
can have same or different levels as
the source estimate.

Shortcut
keys (or
equivalent)

Drag and drop
without Ctrl

Drag and drop
Ctrl +C
Ctrl + V
(with no level changes)

Drag and drop
Ctrl +C
Ctrl + V(with no level changes)

*You cannot move items or assemblies from one estimate to another.

For more information, see the Estimating help.
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Merge Standard Databases
In version 18.12, you can merge two standard databases to create a single standard database.

A newMerge Standard Databases tool is available in the Estimating Management Console. In comparison
with the merge feature in Estimating (Pervasive), the new tool is both significantly faster and easier to use.
For example:

l It is easier to identify source databases, and to add or remove them from the list of databases to
merge.

l We have simplified the rules for dealing with apparent duplicate records.

l We have minimized the renaming or renumbering of records.

Important! Before merging standard databases, you must ensure that you have exclusive access to the
standard databases that you plan to merge.

To merge standard databases:

1. In the Estimating Management Console, click the Tools tab.

2. In the Tools navigation pane, click Merge.

3. In the right-hand pane:

a. Select the Exclusive access confirmed check box, indicating that you have exclusive access
to the databases you are merging.

b. From the Available standard databases list, for each database you want to merge, select the
database name, and then click the right arrow button to move the database to the Selected
standard databases list.

c. In the New standard database name box, type the name you want to give to the new standard
database.

d. Click [Merge].

The merge process begins. If it encounters any issues in merging databases (such as
mismatched values), it displays an error message, and prints the error to a log file.

If there are errors, read the log file to identify the errors, and then fix them before attempting
to merge the databases again. (For example, you may need to remove a database that has
incompatible values from the list of databases to merge.)

e. When the merge process finishes successfully, click [OK] at the message that says the
merged database is ready for use.
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For more detailed information about merging standard databases, see the Estimating Management
Console help for the Merge tool.

Create variables and formulas "on the fly" in the Variable /
Formula List window
With version 18.12, you can add variables and formulas "on the fly" while you add new formula tables or
item tables. If a variable or a formula does not exist in the Variable / Formula List window, you no longer
have to interrupt your workflow to set up the variable or formula, or edit an existing one.

First, use the new List type option in the Variable / Formula List window to display either variables or
formulas in the window. Then:

l To edit an existing variable or formula:

1. Select it on the list.

2. Click [Edit Variable] or [Edit Formula], depending on whether you displayed variables or
formulas.

You can also right-click the variable or formula, and then select Edit Variable or Edit Formula
from the shortcut menu.

3. Use the Database Variable or the Database Formula window to change the properties of the
variable or formula.

l To add a new variable or formula:

1. Click [Create Variable] or [Create Formula].

You can also right-click anywhere in the list, and then select Create Variable or Create
Formula from the shortcut menu.

2. In the Adding Database Variable or the Adding Database Formula window, enter properties
for the new variable or formula.

For more information, see the Estimating help.

Migrate Estimating (Pervasive) report layouts
In version 18.12, you can use the Estimating Management Console to migrate report layouts from
Estimating (Pervasive), as follows:
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1. In the Estimating Management Console, click Data Migration on the ribbon.

2. In the Data Migration window, select step 2—Settings.

a. For the migration Options, select Enable detailed logging so that you can review a list of
migrated layouts when the processes is finished.

b. When selecting data to migrate:

i. Browse to the Options folder that contains your Estimating (Pervasive) report layouts.

ii. Select Report Layouts.

3. Click [Migrate].

4. Review the migration details in the migration Event Log.

Important! Report layouts and spreadsheet layouts are migrated to your personal layouts folder.
Therefore, each Estimating user must migrate their own personal layouts.

If any of the migrated layouts were shared in Estimating (Pervasive) and should be shared in Estimating
(SQL), you need to share the layouts separately for each type of report.

Sharing report layouts after migration

Sharing report layouts after migration is straightforward, but could take some time, depending on how
many layouts you need to share with Estimating (SQL) users, and the number of users who need to share
personal layouts.

To share a report layout in Estimating (SQL):

1. Open the report printing window (for example, on the ribbon, click Spreadsheet).

2. Click [Report Options].

3. In the Report Options window, click Manage Layouts.

4. In the Report Layouts window, on the My Layouts tab, select each report layout you want to share, in
turn, and then click [Create Shared].

Other changes and improvements
Version 18.12 includes the following additional improvements:

l When you undo a Fill Down or Adjust Column operation, Estimating restores the original values to all
the cells you filled or the columns you adjusted.
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l You can add items on the fly, even to a blank assembly.

l When you right-click an item on the spreadsheet, and then click Substitute Item from the shortcut
menu, Estimating opens the Item List at the currently selected item, where it is easy to replace with
similar items.
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Fixes Since the Previous Version

Version 18.12 includes the following fixes:

l In the Item List window, when you click in the list and then start typing, Goto text remains in the title
bar until you type the phase/item code combination. The program then points to the specified
phase/item until you do something else (perform a different operation or click outside the list).

l Select at takeoff settings you specify for assemblies are available at takeoff.

l You can migrate database items that have no categories.

l Migration no longer drops estimate street addresses.

l Estimate names are aligned correctly on variance reports.

l Report previews appear correctly when you switch to a different report layout.

l WBS descriptions appear correctly on standard estimate reports.

l Minimized overlines appear correctly on spreadsheet Reports.

l When you insert a one-time addon in an estimate, information from the previous addon is not filled in
automatically.

l Restored the Include add new item entry on takeoff lists option that was not available in version
18.11.
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Fixes Included in Updates to Version 18.12
We also provide fixes in software updates since we released version 18.12.

Update 1 (Build 1905.091)

This update includes the following fixes:

l When revising a Model Interview that has been taken off to an estimate, Estimating now checks
changed variable values against the assembly-only versions of a variable. Previously it checked the
global variable, even when an assembly-only version existed, which could result in an error
message telling you that the value exceeded the maximum or was lower than the minimum allowed
for the variable.

l We fixed the formatting for some spreadsheet report layouts. Descriptions for minimized overlines
no longer appear too far to the left or right.

l You can now preview spreadsheet reports that use migrated report options.

l When an item with a lump sum follows an item with labor in the spreadsheet, the lump sum is
calculated correctly.

l For estimates that include an allocated addon, after you add the grand total field to the spreadsheet,
the grand total now includes the addon amount.

l When you copy and paste rows from Excel into the spreadsheet, the pasted rows include any detail
and takeoff WBS values.

l In the Default Values window, when you right-click a row, and then click Remove Values, Estimating
clears the Value Description and Notes from that row.

l Estimating functions properly when you try to edit an unnamed layout.

l Estimating no longer displays the personal layouts of another user in the layouts list.

l Default layouts are set correctly during import and migration, even if there is an existing layout with
the same name in the database.

l Estimating does not stop working when there are more locked columns than the number of columns
that are visible.

l Dragging and dropping between estimates in a group/phase sort does not send items to the
unassigned overline.

l When you take off an assembly, open the assembly in Reviewmode, and then undo a pass,
Estimating does not stop working.
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l Crystal Reports that have parameters now print properly. Report parameters use default settings,
which you can view and change in the parameter panel.

l We improved the performance of the installer when applying an update.

l In the Spreadsheet Report, the Totals page is formatted correctly when you use a range or partial
totals in the report parameters.

l When you change the sort order in the Report Options window, the report now prints in the specified
sort order.

l WBS descriptions you enter in overline cells appear consistently elsewhere where the WBS code is
used (for example, for default values, item details, and so on).
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Known Issues

SAP Crystal Reports compatibility with other Sage programs
Version 18.12 uses the SAPCrystal Reports Runtime version 13.0.22, which is not compatible with Crystal
Reports used in these versions of other Sage programs:

l Sage 300 Construction and Real Estate v17.1 and v18.1.

To ensure that you can run and print your Sage 300 accounting reports, you must use Sage 300
Construction and Real Estate v18.2 with Sage Estimating v18.12.

l Sage Fixed Assets 2018.0.

If you use Sage Fixed Assets on the same computer as Sage Estimating, you must use Sage Fixed
Assets 2018.1, or later, with Sage Estimating v18.12.

For more information, see Knowledgebase article KB 93436.

Problem withmigrated standard databases and estimates that
used a job cost interface
If you migrated a standard database or an estimate that was integrated with job cost in Estimating
(Pervasive), you need to perform a few additional steps to reintegrate the standard database or estimate in
Estimating (SQL).

Important! Until you perform the following steps, you will receive a Job Cost Interface Failure error when
you try to edit job cost settings for a standard database or an estimate that was integrated with job cost in
Estimating (Pervasive). Also, you will not be able to use the standard database with new interfaced
estimates in Estimating (SQL).

Before you start

You need to be assigned to a role with Run Management Console, Edit Standard Databases, Edit
Standard Database Settings permissions, and have Edit access to the estimates to use the job cost
system setup.

12Sage Estimating (SQL) v18.12 Release Notes

https://support.na.sage.com/selfservice/viewdocument.do?noCount=true&externalId=93436


For each migrated standard database that used a job cost interface in Estimating
(Pervasive):

1. In the Estimating Management Console, click Standard DB on the ribbon.

2. In the Standard Database Catalog, select the migrated standard database.

3. In the details pane to the right, click [Edit]

4. In the Job Cost Information section:

a. For the Job cost system name, select either None or Text.

b. Click [Save].

c. For the Job cost system name, select Sage 300 Construction.

d. Click [Setup], and enter the job cost settings required to reintegrate the database with Sage
300 Construction.

5. Click [Save].

6. Repeat steps 2 through 5 for each migrated estimate that used the job cost interface in Estimating
(Pervasive).

Note: To edit estimates, you must first click Estimates on the ribbon, and then (in step 2) you
select the estimate from the Estimate Catalog.

You cannot install Microsoft SQL Server from a folder that has a
long path
If you start the Sage Estimating installer from a path that is longer than 100 characters, you will receive the
error “Exit Code 9 The storage control block address is invalid” in the log file when you install the software.

To avoid this error, move the Install folder higher up in the tree (closer to the root folder).

Checking in a Standard Database from the Database Editor
Closes the Database for Concurrent Users
You can work on a Standard database in the Estimating Database Editor while other users perform takeoff
using the same database in the Sage Estimating program.
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When you try to check in the Standard database while other users have the database open, you receive a
warning that if you continue to check the file in, there may be unpredictable results for the concurrent
users.

If you continue to check the file in despite the warning, the Estimating program stops working for the other
users. However, the data is not corrupted and the Estimating program is not damaged.
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Further Assistance

Sage provides you with the following resources for obtaining assistance with Sage Estimating.

Online Help
The Sage Estimating software includes online Help, which provides answers to your questions about
procedures as well as items in the windows.

To view Help in the Sage Estimating software, click the Help button or icon, or press [F1] to display the Help
topic for that window.

For more information about using the online Help, see the Sage Estimating Help.

Training
Sage University offers online and classroom training sessions to help you get the most out of your Sage
Estimating software. To access Sage University, visitwww.sageu.com.

You can also get access to Sage University from the File menu by selecting Help > Sage University.

Technical Assistance
When you need assistance, refer to the Knowledgebase article How do I get technical support for Sage
Estimating? to determine which service works best for you.

Submitting Enhancement Requests
We want to hear your suggestions for improving the software. To send us your comments, click on the File
menu button and select Help > Submit Product Idea.
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